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Desktop Application 5.0

Introduction
The Desktop application makes it possible to place and receive calls using a computer connected to the 
Internet and the backend system. Besides offering basic functions, the application enables Presence 
status management, corporate directory search and instant messaging.

The main features are the following:

•	 Basic call handling - place, answer, record, hold, and retrieve calls
•	 Call transfer
•	 Conference calls
•	 Directory search
•	 Presence handling
•	 Messaging and Collaboration

Licence Limitations
The following features will require eve licensing to have been applied:

•	 Presence - eve Everything Licence
•	 Collaboration (MiTeam) – eve Collaboration Licence
•	 Queue statistics and Agent statistics – Call Queue Supervisor Licence
•	 Chat - eve Collaboration Licence

Minimum system requirements
To install the desktop application, your system must meet the following requirements, at the minimum:

•	 Space required: 300MB for installation and additional 250MB (maximum) for log files.
•	 RAM: 1GB
•	 Screen resolution: 1024 x 768
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Installation and activation
Microsoft Windows Installation
The Windows desktop application may be installed and updated by the end user using the below link.
https://portal.iameve.co.uk/Content/Softphone/Softphone.msi (64-bit Package).

Before installing, be sure to:
1.	 Exit any previous versions of the application by selecting ‘Exit’ from the ‘File’ menu
2.	 Close any Microsoft Office related windows

macOS Installation
The macOS desktop application is installed by running a software installation package. When updating, 
the installation package is opened automatically.
https://portal.iameve.co.uk/Content/Softphone/Softphone.dmg

Before installing, make sure to:
1.	 Exit any previous ver sions of the application by selecting ‘Exit’ from the ‘File’ menu
2.	 Close any Microsoft Office related windows

Microphone Access on macOS Mojave
With macOS Mojave, the user is prompted to configure microphone access once. If the user does not 
grant access, the user will have to modify the microphone access from the ‘Security & Privacy’ prefer-
ences.

ttps://portal.iameve.co.uk/Content/Softphone/Softphone.msi
https://portal.iameve.co.uk/Content/Softphone/Softphone.dmg
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User Interface Overview

1.	 User area. Contains your picture, presence (Everything licences only), name, Caller ID, diversion info 
and note. Clicking on your picture opens your vCard.

2.	 Live aid area – you can see notifications for missed calls, transfers, etc. here
3.	 Search field
4.	 Tab bar – contains tabs to switch between the different views.
5.	 Contacts/Calls/Log area. Each tab view contains different information regarding contacts, ongoing 

calls, log, etc.
6.	 Volume bar.
7.	 Click the toggle between speaker/headset mode.
8.	 Click to mute/unmute microphone.
9.	 Click to switch which device to call from ‘Call using’.
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Icons
There are several function icons and buttons in the application. 
This section lists the most used.

Presence Icons

Icon Description

Contacts

Calls

Log

MiTeam

Queue Statistics

Agent Statistics

Group Log

Icon Description

The contact’s presence state is available

Contact is in a call

The contact’s presence state is unavailable

The contact has a meeting that starts within
60minutes according to Outlook

The contact is in a meeting according to Outlook

Current activity end time available

Current activity end time expired

You have an activity diversion configured

You have an important message by system
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Active calls and buttons

Icon Description

Opens a keypad for sending tones

Record the call

Stop recording of the call

Activate transfer

Dropdown menu

Add the call to a conference

Click to park the call

Pick up a parked call

Re-queue call

Click to hold the call

Continue with the call held

Hang up the ongoing call

Answer call

Encrypted call

Unencrypted call

The calling identity is asserted by the server

Move call to another phone

Mute incoming call ringer

Unmute incoming call ringer
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Other buttons and icons

Icon Description

Click to expand the contacts info

Click to call (using desktop application)

Click to call (using mobile phone)

Start chat / Collaboration

Start chat / Collaboration (contact is away)

Edit the contact entry

Add the contact to your Favourites list

Remove the contact from your Favourites list

Block the contact fom calling you

Add the contact as VIP

Delete local contact or an item

Logged in to an ACD or Attendant group

Logged out from ACD or Attendant group

Call using desktop application (default)

Remote call control for deskphone call

Remote call control for mobile call

Speaker mode activated

Headset mode activated

Mute and un-mute the microphone

Play the recorded message

Assign calls to yourself and other agents (supervisor)
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Menu bar
The menu bar contains options related to tools, view, calls, services and help. This section describes the 
important menu options.

Options/Preferences
The ‘Options’ (on Windows) or ‘Preferences’ (on OS X/macOS) menu is divided into four areas:
•	 Account
•	 Audio
•	 General
•	 Advanced

To go to your desktop application options (Windows):
•	 Select ‘Tools’ > ‘Options’ in the menu bar

To go to your desktop application preferences (OS X/macOS):
•	 Select your desktop application’s name in menu bar and choose ‘Preferences’

Account
The ‘Account’ option shows the account configured on the desktop application. From here you can log 
out of the desktop application.

To log out of the desktop application:
1.	 Go to the ‘Account’ in ‘Options’ or ‘Preferences’
2.	 Click ‘Logout’

The action will log you out of the application and will take you to the activation screen.

Audio
The ‘Audio’ option lets you configure your audio settings when using the application as a speaker phone 
or with a headset. You can also configure a custom ringtone.

Speaker profile
The ‘Speaker’ tab is used to configure the sound devices that th e application will use in the speaker 
profile. Use the speaker profile when using your computer as a speaker phone.

You can select the audio devices that should be used in the spe aker profile. We recommend selecting 
the audio device that is connected to the computer speakers.

Headset profile
The ‘Headset’ tab is used to configure the sound devices that th e application will use in the headset 
profile. This setting allows you to make calls via your computer using a headset.

You can select the audio devices that should be used in the hea dset profile. For ‘Input’ and ‘Output’, 
select the audio device that is connected to the computer’s headset. This audio device typically belongs 
to a connected USB headset. For the ‘Ringer’ device, select an audio device that is connected to the 
computer speakers.
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Audio settings
The following settings are configured for each profile:

•	 Input audio device – the audio device to which the microphone is connected
•	 Output audio device – the audio device to which the speaker or headphone is connected
•	 Ringer audio device – this audio device will be used to play ring signals

Ringtone
You can set a custom ringtone to differentiate your phone from the other phones in the office.

To change the ringtone:
1.	 Go to the ‘Audio’ option in ‘Options’ or ‘Preferences’
2.	 In the ‘Ringtone’ drop-down list, select ‘Choose’ to browse for a new ringtone
3.	 Click ‘OK’

General
The ‘General’ option is used to configure desktop application behaviour, notifications, and keyboard 
bindings. The following settings can be made.

Automatically start when the computer starts
This setting allows the application to be started when the computer is powered on. ‘AutoStart’ 
isselected by default.

Compact contact list
This setting shows a compact contact list instead of an expanded contact list that shows contact avatar.

Automatically answer incoming calls
This setting makes it possible to have the application answer incoming calls automatically without any 
active interaction from the user. When in call, the calling party is placed in a queue or will hear a line 
busy tone depending on server configuration.

Integrate with Address Book
Mark the checkbox if you want to integrate the desktop application with the address book on macOS or 
with Microsoft Outlook on Windows. This will let you get search results from MS Outlook on Windows or 
from the Contacts app on macOS. Incoming calls will also be matched against contacts.

Pop-up for incoming call
This setting makes the application to pop up in the foreground for incoming calls.

Answer with Enter
Mark this checkbox to enable call pickup using the enter or return key on your keyboard. For agents 
answering multiple calls, this setting allows them to pick up incoming calls by simply pressing the enter 
key on their keyboard.

The checkbox is disabled if ‘Automatically answer incoming calls’ is enabled.

The behaviour of secondary numeric enter key is not configurable and pressing it will always result in 
answering the incoming call, regardless if the ‘Answer with Enter’ setting is enabled or not. The enter key 
triggers call pick up only if the ‘Calls’ tab is active on the desktop application. It may notwork as expected if any 
other tab or window is active.
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Notifications
This setting lets you configure notifications that you want to re ceive.

Configure keyboard bindings
Pressing the ‘Keyboard’ button will open the keyboard bindings dialogue. This dialogue shows all current 
keyboard shortcuts. It is also possible to reassign keyboard shortcuts for all the commands.

Item Description:
Go to input field - Go to search field
Go to calls - Go to ‘Calls’ tab
Go to contacts - Go to ‘Contacts’ tab
Answer – Answer an incoming call
Hang-up – Hang-up an ongoing call
Start transfer - Initiate a transfer
Hold/Resume - Put call on hold or resume on-hold call
Park - Park a call
Re-queue - Return a previously camped-on call to a target user’s personal queue.
Copy - Copy selected text
Paste - Paste text from clipboard
Cut - Cut selected text (if allowed)
Select All - Select all
Start transfer, bypass diversion rules - Initiate transfer and bypass diversion rules

Advanced
The ‘Advanced’ option is used to configure specialized settings.

Use the ‘F8’ key to dial the selected number
Mark the checkbox if you want to call a selected number using the desktop application by simply 
pressing ‘F8’. The desktop application filters out invalid chara cters automatically.

Show queue information in standard view
Mark the checkbox if you want to show your group buttons and queue information in ‘Standard’ view.

Automatic adjustment of microphone gain
Mark the checkbox if you want to have automatic adjustment of microphone gain. This can prevent 
getting unwanted audio feedback.

Enable monitored calls and call control
This option enables monitoring of your own ongoing calls, regardless of device/client that calls are 
initiated from (i.e. mobile, desktop, or phone). You can also start and control calls made from another 
device from the application.

Note that for external calls, contact names in monitored calls are shown only for desktop-initiated calls and 
when the external contact exists in the address book. For calls initiated by a client, other than the desktop 
application, only contact number is shown regardless if the contact is saved in address book or not. This is a 
known limitation.
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The following call activities are available:
•	 Start
•	 Park
•	 Blind transfer
•	 Hang up
•	 Move to another device

Tools
The ‘Tools’ menu contains shortcuts to the following functions:
•	 Home
•	 Profile
•	 Inbox 
•	 Add contact

•	 Schedule meet 
•	 Call routing
•	 Future presence

Home
‘Home’ opens a web browser and the option to log on to the Self-Service Portal. The Self-service Portal 
contains different settings.

Profile
Your profile is where you set your personal information, such as :
•	 Update directory information
•	 Change your photo

•	 Change your password
•	 Change your PIN code

To go to your profile:
•	 ‘Click Tools’ > ‘My profile’

Inbox
The inbox contains all your messages in the system. The inbox i s a filter in your Log. The messages can 
be either voice mail, fax, or recordings.

To go your inbox:
•	 Click ‘Tools’ > ‘Inbox’

To play or read a message:
•	 Click the message.

To delete a message:
•	 Select a message and click ‘Delete selected’

Add contact
The ‘Add contact’ option is used to create a new contact as a ‘Contact’, ‘Favourite’, ‘VIP’ or ‘Blocked’ 
contact.

Favourites, VIPs, and blocked contacts
Your contacts are either default contacts or one of the following:
•	 Favourite - a contact that is displayed in your contacts list when you do not have an active search 

query.
•	 VIP - a contact, also added to Favourites, that you can add s pecific call routing rules for. Rules set 

both for VIP and Favourites will apply to VIP contacts.
•	 Blocked - a contact that you can add specific call routing rul es for.
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To add a new local contact:
1.	  Click ‘Tools’ > ‘Add contact’
2.	 Select if the contact should be added as a ‘Contact’, ‘Favourite’, ‘VIP’ or ‘Blocked’ contact.
3.	 Enter the contact details and add a phone number. It is possible to add more than one phone 

number for a contact.
4.	 Click ‘Ok’ to save the contact information. The contact is added to your contact list. You can then set 

call routing rules depending of the type of contact.

Schedule meet
Using the ‘Schedule Meet’ option, you can schedule a voice meeting by inviting multiple participants to 
the call.

If your organisation has collaboration enabled, you are redirected to the Collaboration tab where you can 
perform meet activities (see Collaboration documentation for more information). If your organisation 
does not have Collaboration enabled, a pop-up is shown where you can perform basic
meet activities (based on your conferencing licences).

Future presence
With future presence you can view and schedule presence events.

To add a new future event:
1.	 Click ‘Tools’ > ‘Future presence’
2.	 Click ‘+’
3.	 Add your info, period and if the event should be repeated. You can map diversions to the activity 

from the ‘Activity diversion’ setting.

User area
In the user area, you can view or set the following:
•	 vCard
•	 Caller ID
•	 Presence and activity
•	 Personal note

vCard
Your vCard displays your contact and organizational information such as:
•	 your name
•	 your business and mobile phone numbers
•	 your email
•	 your company information
•	 your title/occupation

To view your vCard:
•	 Click on your picture in the desktop application.

To close your vCard:
•	 Click outside the vCard/picture area. You can perform additional actions using the information displa 

yed in your vCard fields.
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Presence and activity (eve Everything Licence only)
As a user in the system, you can select between different activities and roles available in the system. 
For example, if you want to have your calls routed to a specific phone when you are out of office, it is 
possible to set a specific role and activity matching the case.

Activities
To set an activity:
•	 Click on the activity area and select a new activity from the drop-down list or select ‘Activity’ and 

‘End time’ from ‘Custom activity’.

The following default activity types are available:
• Available
• Busy
• Lunch

• Meeting
• Out of office
• Holiday

Custom activity
A custom activity will let you set a new active activity, availability, end time, and activity diversion.

Future presence
You can schedule your future presence events.

Activity diversion
You can configure activity diversions that will automatically di vert calls to your number based on your
activity.

To add an activity diversion:
1.	 Click on ‘+’ button
2.	 Select your activity
3.	 Set a number to divert to
4.	 Click ‘Save’
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Change another user’s presence
You can change the presence information regarding activity, role, future presence and change the per-
sonal note if you have the authorization for it.
If you belong to a group that has only the right to see the future presence information of the contact, 
the menu only displays the ‘Future presence...’ item. Click this item to see the current presence state of 
the contact.

To change another user’s activity:
1.	 On the desired user, click on the activity
2.	 Select the new activity or ‘Set activity and end time’ to set an end time to the activity

To change another user’s role
1.	 Expand the desired user contact card
2.	 Click on the role
3.	 Select the new role from pop-up menu

To change another user’s future presence
1.	 On the desired user, click on the activity
2.	 Select ‘Future presence’ from the pop-up menu to see and set the future presence for the user.

To change another user’s personal note
1.	 On the desired user, click on the personal note area.
2.	 Enter the new note.

Personal note
It is possible to add a personal note that will be visible to other users within the organisation.

To add a personal note:
•	 Click the note field on the user area and add the desired note.

Search directory
The directory includes all contacts in your organisation.

To search for a contact in directory:
•	 Start entering characters of contact name in the search field. The search results are updated 

automatically based on your input.

Search results are limited to 25 hits and are shown depending on the search string entered. Refine your 
search to view more specific results.

Contacts
This shows all your contacts together with their presence information.
By default, your ‘Favourites’ list is displayed and you can search for other directory contacts by entering 
their names in search field.

From the ‘Contacts’ tab, you can:
•	 View contact details
•	 Add a contact by directory search
•	 Remove favourites
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•	 Delete a local contact
•	 Edit contact information
•	 Start chat with a contact
•	 Call a contact

View contact details
Contact details show you extended contact information such as role, contact information (phone 
number and email, and other company information.

To view contact details:
•	 Click on the contact’s name, picture, or press the expand button (>) to view expanded contact card.

Contact card actions
From the contact card, you can perform additional actions on the contact card fields. These actions 
include:
•	 Call the contact on displayed number.
•	 Send an email to contact using your default email application.
•	 Search the local and organization directory using text or number displayed in contact field.
•	 Copy field information to clipboard.

To perform an action using contact card fields:
1.	 Expand the contact card to view contact details
2.	 On the desired field (e.g. mobile, email, department), click the additional actions button (>)
3.	 Choose the desired action from pop-up.

Add contact by directory search
Your ‘Favourites’ list is the default view in ‘Contacts’ tab. A maximum of 40 favourited contacts are 
displayed in your contact list.

To add a contact by directory search:
1.	 Search for the desired contact using the search field
2.	 Expand the contact card
3.	 Click the ‘Set this contact’s state’ button ( ).
4.	 Choose how the contact should be added, that is, as a favourite ( ), contact ( ), VIP ( ), or 

blocked ( ).

Local contacts
You can add, edit, and remove local contacts in your favourites list.
•	 If you want to edit a local contact, click on ‘Edit this contact’ button ( ).
•	 If you want to delete a local contact permanently, you can click on the ‘Delete this contact button’ (

). You can only delete local contacts.

Remove favourites
To remove a contact from your favourites list
1.	 Expand the contact’s card.
2.	 Press the ‘Set this contact’s state’ button ( ).
3.	 Choose ‘Contact’ ( ) from pop-up menu.
4.	 Confirm the action in dialogue box.

On the live aid area (under your contact name) you can view the notification if the contact was removed 
successfully.
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Delete local contact
A local contact is a contact present locally in your contact list and is not available or searchable in the 
organisation directory.

To delete a local contact:
1. Expand the contact card of the desired local contact.
2. Click the Delete this contact button ( ).
3. Confirm the action.

Edit contact information
You can edit the contact information for contacts that you have created. You cannot edit the contact 
information for contacts within your organisation.
To edit a contact’s information:
1.	 Expand the contact card of the desired contact.
2.	 Click the ‘Edit this contact’ ( ) button.
3.	 Edit the desired information.
4.	 Click ‘OK’ to save changes.

Start chat with contact (Requires Collaboration Licence)
To start chat with a contact:
• On the desired contact in ‘Contacts tab’, click the ‘Start chat’ button ( ) or ( ).

The action redirects you to the Collaboration tab where chat and other Collaboration activities can be 
performed.

It is not possible to start a chat session with a contact belonging to a linked organisation.

For more information on Chat and Collaboration, see the Collaboration documentation.

Calls
This section describes call related features:
•	 Call panel overview
•	 Line state
•	 Place a call
•	 Answer a call
•	 Hang up or reject a call
•	 Hold and resume a call
•	 Park a call
•	 Transfer a call
•	 Move call to another client
•	 Send DTMF tones
•	 Record a call
•	 Conference calls
•	 Volume control
•	 Remote call for calls with another phone
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Call panel overview

1.	 Connected party’s name and number
2.	 Contact details including vCard – short number is presented if available
3.	 Mid-call options
4.	 Call state and duration of call. The call state shows whether the call is ringing, connected, on hold, 

etc.
5.	 Sign if the user is asserted by the system The call state shows whether the call is ringing, 

connected, on hold, etc.
6.	 Encryption status – the padlock indicates whether the call is encrypted ( ) or not encrypted ( )
7.	 Network quality measured on the caller side as well as on the called party side.

Line state
When a contact is in call, this is indicated by the line busy icon ( ) in the contact list.

Place a call
To make a call to a contact:
• On the desired contact, click the call icon ( ).

To make a call using name or number search:
1.	 Enter full or partial contact name or number in the search field.
2.	 If needed, select the contact using arrows or mouse.
3.	 Press the return key.

The call button will change depending on which device that you will call with. For example, the desktop 
application, a desk phone, or mobile.

You can also call a contact directly from a chat session.
It is also possible to make a call even if there is an incoming call.

Advanced calling options
The advanced call options for the application include:
•	 Bypass diversion rules
•	 Intrude ongoing call
•	 Calling as
•	 Call with/Call using

The options are available in the ‘Call’ menu option.

Bypass diversion rules for next call
Selecting ‘Bypass Diversion rules for next call’ will override any diversion set on the calling party. This 
option is only effective for the next call and on the desktop application.
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Call with/Call using
You can see whether you have ‘Call with’ or ‘Call Control’ capabilities in the bottom left corner (device picker). If 
the title says ‘Call with’, you have Call with capability and if the title is ‘Call Control’, then you will also be able to 
control the calls using the desktop application.

‘Call with’ can be used if you want to set up your call using the application but want to handle the actual 
call using another device. For example a mobile phone or a desktop phone.

You can see which device you will call with in the 
bottom left corner of the desktop application. In the 
following picture the user calls with mobile phone.

Click on the icon to choose which device you would 
like to call with. You can also configure ‘Call with’ 
using the ‘Call’ > ‘Call with’ setting in the desktop 
application. For example, if you select to ‘Call with 
Mobile’, your mobile phone will ring. Pick up the call 
and the mobile phone will automatically connect to 
the called party. You can see the call set-up progress 
in the ‘Calls’ tab in the desktop application.

If enabled, you can also control the remote call from the softphone by calling using the ‘Call Control’ 
feature.

Answer a call
To answer a call:
• When a call is received, click the ‘Answer Call’ button ( ). Alternatively, you can answer the call by 
pressing the numeric enter key on your keyboard.

You can also answer the call from the desktop application icon in the taskbar (Windows) or dock (OSX/ macOS). 
Right-click the icon and select ‘Answer Call’.

You can mute the ring signal of an incoming call.
To mute ringer of an incoming call:
•	 Click ‘Mute Ringer’ button ( ).

Hang up or reject a call
To hang up or decline a call
•	 Click the hang up call icon ( ).

You can also decline or hang up a call using the application icon in the taskbar (Windows) or dock (OS X/ 
macOS). Right-click the icon and select ‘Decline’ or ‘Hang-up’.

Hold and resume a call
To hold an ongoing call:
•	 Click the ‘Hold Call’ button () or place a new call using the main window.

Placing a new call will automatically put the ongoing call on hold. The held party will hear music-onhold, 
spoken hold information in your locale, or another prompt depending on configuration in the system.
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To resume a call:
•	 Click the ‘Resume call’ button ( ).
 
If another call is active, clicking ‘Resume Call’ will automatically put the active call on hold.

Park a call
It is possible to park calls in the personal queue.

To park a call:
•	 During an ongoing call, click the ‘Park Call’ button ( ). The call will be parked in the queue.
If allowed, other users can also pick up the parked call.

Transfer a call
This section describes call transfer functionality in the desktop application.

Blind transfer
A Blind transfer allows a user to transfer a call to another user without introducing the call. If the 
transfer fails due to no answer or a busy line, the transferred party can connect with the party that 
transferred the call again.

During a transfer, new incoming calls are placed in your personal queue, if no other call routing rules apply. You 
can pick up a new call in the queue by clicking on the ‘Pick-up the call’ button.

To make a Blind transfer:
1.	 During a connected call, click the ‘Activate Transfer’ button ( ).
2.	 Search for or dial the contact to transfer the call to.
3.	 Click the ‘Transfer to here’ button ( ) on the contact to transfer the call to.

To make a Blind transfer, bypassing any diversion rules:
1.	 Click the ‘Transfer Options’ button ( ).
2.	 Select ‘Bypass Diversion Rules’.
3.	 Search or dial the contact to transfer the call to.
4.	 Click the ‘Transfer to here’ button ( ) on the contact to transfer the call to.

Attended transfer
Attended transfer makes it possible to transfer a call, while fi rst getting the option to talk to the party 
where the call is being transferred. If the called party accepts the transfer, the remote party will relate to 
the new party and it is possible to leave the call.

1.	 During a connected call, place another call – the (first) con nected call will be placed on hold.
2.	 Wait for the party to answer.
3.	 Switch back to the first call and click the ‘Activate Transfe r’ button ( ) to start transferring the 

call.
4.	 Click the ‘Transfer to here’ button ( ) on the called party. It is also possible to drag and drop a call 

to another in the call panel.

Failed transfer
Whenever a transfer or park/camp-on has failed, you will get no tified and can pick-up the call again. 
This could be, for example, if the contact you transferred the call to declined to answer. The call will be 
placed on hold, and the call will flash in the call view of your application to let you know that this call 
requires immediate attention.
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Move call to another client
It is possible to move an ongoing call in the application to another client, for example a mobile phone or 
a desktop phone.

To move a call to another client:
1.	 Select a device from the ‘Move this call to’ drop-down list.
2.	 Click the ‘Move call’ button ( ).

Send DTMF tones
If you call a voicemail or any other interactive voice response service where telephone tone dialling 
(DTMF tones) is required, it is possible to open a keypad from the active call panel. You can also use the 
numeric keypad on your keyboard to send the tones.

To send DTMF tone:
1.	 When connected in a call, click the ‘Open keypad’ button ( ) in the active call panel to open the 

keypad.
2.	 Click the numbers to send.

DTMF tones are sent as soon as you start pressing digits on the keypad. You may remove numbers (one by one) 
using the backspace key or use escape key to clear the entire keypad screen, but any DTMF tones already sent 
will not be affected.

Record a call
During an ongoing call, it is possible to record and save the conversation to a file.

To record a call:
1.	 Press the ‘Start Record’ button ( ) to start the recording.
2.	 Press the ‘Stop Record’ button ( ) to end the recording.
Go to ‘Inbox’ under ‘Log’ to listen to the recorded call.

If a call is on hold, it will be resumed when you start to record a call.

Conference calls
Create a conference call
The following steps describe how to set up a local conference call.

To set up a conference call:
1.	 Receive or place a call.
2.	 When the call is connected, click the ‘Add Call to Meet’ button ( ). The ‘Conference call’ panel is 

opened, containing the active call. Additional calls can now be added to the conference.
3.	 Place another call – the active call will be placed on hold.
4.	 When the new call is connected, click the ‘Add Call to Meet’ button ( ) to add the call to the 

conference.
5.	 Repeat placing new calls and add to the conference to add more participants.

A maximum of six participants including the host can participate in an ad-hoc conference. This is a system limit 
and is not dependent on any licence requirements.
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Disconnect participants
The conference call panel displays all connected participants in the conference.

To disconnect a participant from the conference
•	 Click on the selected participant to disconnect or to put a participant on hold.

End a conference call
A conference call is ended when the conference organiser disconnects the call, or when all participants 
has been removed from the conference call.

To end a conference call:
• Click the Hang-up button ( ) to terminate the conference call.

The conference organiser will have the option to allow the rest of the participants to continue 
conferencing when disconnecting. Allowing this will move all other participants to the conference server.

Volume control
You can control the volume for a call and switch between headset mode and speaker mode from the 
bottom area of the desktop application.

You can mute your microphone by clicking on the ‘Mute Microphone’ button ( ).

You can also mute the microphone from the taskbar/dock icon. Right-click the desktop application icon and 
select ‘Mute Microphone’. To unmute, select ‘Unmute Microphone’.

Remote call for calls with another phone
You can call with another mobile or desk phone, 
but control the call using the desktop application. 
You initiate a call using the desktop application and 
can control call transfers, park call/pick-ups and 
much more using the user interface of the desktop 
application. 

After initiating the call on the desktop application, 
you need to answer it manually on the device that 
you want to control. The remote call control feature 
needs to be enabled by your service provider.

To choose which device to call with or control, click the device button by the ‘Call Using’ button) in the 
bottom left of your app window, as pictured.

You can see whether you have call with or call control capabilities in the bottom left corner device picker.

To place a call with remote call control:
1.	 Click the device button ( / / )
2.	 Select the device that you want to call from
3.	 Search for a contact or enter a phone number and place the call as you would normally do – the 

server will initiate a call-back call to your selected device
4.	 Answer the call on your selected device
5.	 The ‘Calls’ view will open in the desktop application and you can control the call from there.
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Log
The Log tab shows placed, received, missed calls, voicemail, recordings and fax messages. The time and 
duration of the events is also shown.

From the ‘Log’ tab you can:
•	 Filter log items
•	 Delete log items
•	 Listen to a voicemail or call recording
•	 View fax message

It is also possible to place calls using the log. Click the ‘Call Using Softphone’ button ( ) on the desired log 
item to place the call.

Filter log items
You can filter the log by all calls, missed calls, or inbox items.
The following filter buttons are shown in the Log tab:
•	 All - Shows all calls and inbox items
•	 Missed calls - Shows only missed calls
•	 Inbox - Shows only inbox items

To filter log items:
•	 Click on the desired filter button to view items in your preferred filter.

Delete log items
You can delete a single or all log items shown in your ‘Log’ filter.

To delete a single log item:
1.	 Click on an item to expand it.
2.	 Click the delete icon ( ).

To delete all log items:
1.	 Choose the desired filter that shows the items you want to delete.
2.	 Click the ‘Delete all items’ button ( ).

Listen to a voicemail or call recording
To listen to a voicemail or call recording:
•	 Click the ‘Play’ button ( ) on the desired item.

Expand the item to view additional playback options.

View fax message
To view a fax message:
• Click to download the fax message.

The fax message is in PDF format and your preferred PDF reader will be opened automatically to show 
the message.
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Collaboration (MiTeam) 
(Requires Collaboration Licence)
The Collaboration tab provides features for enhanced Collaboration, such as chats, streams and meets. 
Documentation for Collaboration is released separately. 

ACD functionality (Windows only) 
(User is required to a member of a Call Queue)
13.1 ACD agent view
The ‘ACD agent’ view contains the menu and the call information field with the possibility to dock the 
field to the top or the bottom of the screen. The call handling function is the same in the ‘ACD agent’ 
view as in the ‘Standard view’.

To switch to the ACD agent view:
•	 In the menu bar, select ‘View’ > ‘ACD Agent view’.

Queue handling
The top of the view presents the attendant and ACD groups you belong to, if you are logged in or 
out, and agent status. The number of available agents and calls in queue are displayed in in the form 
(number of calls waiting [logged in agents/available agents]). If calls are in queue in a group, the waiting 
time for the first call is also shown. If you have logged in to an attendant group, you are able to pick up 
calls for the attendant group. It is also possible to see the number of calls in the queue and the time for 
the first call in the queue.

Group login
You can see your login status on the group buttons on top of the application window and log in or log 
out by pressing the buttons.

The login/logout buttons are highlighted for the groups you are logged into:

Manager assistance
When logged on as an ACD agent, it is possible to request assistance from a manager by calling a 
predefined number.

Click ‘Help Me’ in the ACD agent view to call for manager assistance.
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Group log (ACD)
The ‘Group log’ view displays the call log for ACD groups that you are member of.

To view the ACD group log:
•	 Click the ‘Group log’ tab in the desktop application.

This view displays, in the left pane:
•	 A summary of the total number of calls, and number of calls in each status category, surrounded by 

a colour-coded circle displaying the proportion of calls in each category:
•	 All Calls
•	 Missed – colour-coded in red
•	 Forwarded – colour-coded in orange
•	 Answered – colour-coded in green
•	 Option to filter the list of log items by group
•	 Option to filter the list of log items by assignee

The right pane contains a list of log items, displaying the following fields:
•	 The phone number or name of the caller, and under this field the number of calls to the group with 

the same status and from the same number or caller.
•	 The group names. If a watch icon is displayed, it indicates that the call was forwarded because the 

queue was scheduled as closed at the time of the call.
•	 The recipient, showing the state of the call, that is, unhandled, in progress (being handled), or 

handled.
•	 Unhandled state shows only the handle button ( ).

As an agent, you can assign the item to yourself. As a supervisor, you can assign the item to any agent.

•	 If an assignee with white cell background is shown, it means that the call is being handled.
•	 A grey cell with assignee means that the call has been handled.
•	 A phone handset icon, surrounded by a circle in the colour indicating the call status (as described 

above), and the time or date of the last call.
•	 A note regarding the log item. A ‘+\ sign on the note icon is shown if the note is empty and can be 

entered. Up to 255 characters are allowed in a note.

To filter the list by a given status:
•	 Click the corresponding circle in the left pane.

To display the unfiltered list:
•	 Click the ‘All Calls’ circle at the top of the left pane.

To filter the list by a given group:
•	 Open the drop-down list in the left pane and select the desired group.

To filter the list by an assignee:
•	 Open the drop-down list in the left pane and select the desired assignee.

To assign an item to yourself:
•	 Click the handle button ( ) on the desired item and then click ‘Assign to me’

To assign an item to an agent (as a supervisor):
•	 Click the handle button ( ) on the desired item and then choose the desired agent and click 

‘Assign’
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To call from the group number call log:
•	 Click the handset icon at the right of a log item

Calling from the group number call log has the following effects:
The ‘From’ number is set as configured on the server. If this feature is enabled on the server, calling from 
a ‘Missed log’ item sets the item to ‘In progress’. If the call is unassigned, it will be assigned to the agent 
who initiates the call. If the call is already assigned to an agent, the assigned agent will not change.

Queue statistics and Agent statistics 
(Call Queue Supervisor licensc is required)

An ACD supervisor who is authorised to supervise specific groups, can see the widgets ‘Queue statistics’ 
and ‘Agent statistics’ for these groups. They appear as extra tabs in the ‘Standard view’ and the 
‘Attendant view’. Using the widgets, the supervisor can see the statistics for the groups and log in and 
log out agents to these groups.

Queue statistics
The ‘Queue statistics’ widget shows all the ACD and attendant groups you are authorised to supervise 
and lets you log in and log out agents to these groups. The statistics is presented in the administrator 
configured running time span.
•	 Group – The name of the group. Click on the group to expand it.

When expanded, the group provides:
•	 Agent members of the group, with logged out agents having names in grey.
•	 Agent status.
•	 Skill, where skill 1 is the highest and 5 the lowest skill.
•	 A button to log in or log out the agent to or from the group.
•	 # in queue – Number of persons in the queue.
•	 Last wait – The time in minutes seconds the last picked up call waited before the call was picked up.
•	 Avg wait – The time in minutes seconds the average call in the configured time span waited before 

the call was picked up.
•	 Dropped – The number of calls that were hung up by the callers before they were picked up.

Agent statistics
The ‘Agent statistics’ widget shows all the info provided by the ‘Queue statistics’ widget, but it is sorted 
by agent name instead of group name.
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Mobile and iPad guide

My mobile app lets you use all my features on the go through your iPad or mobile phone. Search your 
contacts, see who’s available, talk to and even instant message your colleagues using my smart easy to 
use interface.

Control where your calls ring, set your availability status for now or schedule for the future all through 
my app! The user interface of this app can be different depending on whether or not the user also has a 
Collaboration licence:

User doesn’t have a Collaboration licence:
The Chat feature is shown and you are able to create a new Chat by searching for a contact in search bar.

User has a Collaboration licence:
The user will be able to see the ‘MiTeam’ tab. This allows you to create interactive Streams, schedule 
Meets and instant message your colleagues. If you upgrade to a Collaboration licence, any existing Chats 
are deleted.

To get started with a mobile or iPad choose an option below:
Activate using your mobile number
1.	 You will receive a welcome SMS from ‘iameve’ which will contain a link to download the application.
2.	 Click the link and download the application.
3.	 Once downloaded, open the application and populate your mobile number, including the country 

code.
4.	 Press the ‘Get activation code’ button to activate a code which will be sent to you via SMS and 

email.
5.	 Use this code to validate the app by populating the box and pressing the ‘Activate’ button.
6.	 Now you’re ready to start using my app!

Activate using your eve password
1.	 After installing the app, select the link to login with username and password method
2.	 Fill in your username and your password
3.	 Press ‘Login’
4.	 If provided credentials are correct, your app is activated and should present you the main view
 
eve calls
eve for Mobile supports eve calls. This is a valuable feature if you are in an area with poor mobile phone 
coverage but a good internet connection, or if you are using the eve Mobile app in the office. eve calls 
are made available based on user agreements, network availability and operator restrictions. When VoIP 
calls are available, the user must enter the credentials necessary to authenticate with the eve server 
and choose the type of network it can use when placing eve calls.

To enter the credentials:
1.	 Select ‘Settings’ from the menu to the left.
2.	 Type your username
3.	 Type your password
4.	 Click ‘Login’
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NOTE:
•	 Use the same user ID and password that you used to login to the eve portal.
•	 If VoIP calls has initialised successfully, a ‘Logout’ button will be displayed. The ‘Logout’ button may 

be used to stop receiving VoIP calls on your mobile. In case the log in is not successful, the user will 
get an information message.

•	 The user can configure the type of mobile network that may be used to make VoIP calls. For 
example, if the user only wants to enable VoIP calls, when a WiFi network is connected.

Settings
To set network preferences:
1. Select ‘Settings’ from the menu to the left.
2. Select ‘Networks’

eve calls are like traditional mobile calls, you can answer an incoming eve call, hang up or reject a call. 
You can also send touch tones* which will allow you to select options on an auto-attendant.
The phone user should be aware that a situation may arise where the user will receive a mobile call 
during an eve call. In this case, the mobile call will always have precedence and the eve call will be put on 
hold. There are some important distinctions between eve calls and traditional mobile calls:

•	 eve calls require an internet connection for example WiFi or 3G/4G. It will not be possible to make 
eve call without a working internet connection.

•	 eve calls received during an ongoing mobile call will be rejected.
•	 A busy signal is played if one of your eve contacts declines an eve call from you.

DTMF tones
*Dual Tone Multiple-Frequency (DTMF), also known as Touch Tones or Tone dialling, are supported 
while in a VoIP (eve) conversation. A DTMF keypad can be accessed while in an ongoing VoIP call and 
minimised when no longer required.
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Starting the app
When starting the application, the user will arrive at the ‘Contacts’ view, the
main view of the application. Sliding using the handle on the right reveals the
quick presence view where users can set, access and add presence shortcuts, as
well as set diversions.

Sliding using the handle on the left reveals the navigation menu where the user
can pick between different views and see notifications regarding, for instance,
unread Chat messages or recently added log items.

Navigation
When using the handle to the left in your view you will see the navigation menu.
The items present in the menu are: Contacts, Me, Chats, Dialler, Call log, Groups,
MiTeam, Future presence, Activity diversion, Settings and About. You may also
have some web views.

Depending on the settings for your system you can have a different list and
order of the menu items. The starting view is the first of the navigation views.
To close the menu simply slide the view back or pick one of the views in the menu.

Activity view
The ‘Activity’ view is accessed by dragging handle to the right. In the activity view
you can view and set your current presence state.

Shortcuts
Use shortcuts to set your presence easily. To add a new shortcut, press ‘Add
a new shortcut’. Then set the name, activity, availability, duration, diversion
number and an icon can be specified while creating a shortcut.

When setting a shortcut or setting a custom activity the active diversion may be
changed.

The following applies:
•	 Use default diversion - The active diversion is automatically set to the diversion 

created within ‘Activity Diversion’. If this has not been set your phone will not 
automatically divert.

•	 Ignore default diversion - This will clear any previous set diversions.
•	 Override default diversion – This will override the current divert number and will 

allow you to replace it with a new one.
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Availability
Availability for an activity can be overridden from the ‘Custom activity’ view that
can be opened by pressing on the more icon. Possible override options are:

•	 Available sets green icon with the activity.
•	 Do not disturb sets red icon with the activity.

Call routing rules can be added based on the availability.

Contacts
In the ‘Contacts’ view the presence state, call status and notes of all your
contacts can be seen. Your favourites list is displayed by default and you can search 
for other directory contacts.

You can tap and hold on a contact to display a pop-up dialogue with all
communication options for that contact. If you tap and hold on a local contact
you will get the option to add them to your ‘Contacts’ or share the contact
to another user. Tapping on a contact will open up the detailed view of the
contact.

How to enable yourself to add your favourites to ‘Contacts’:
1.	 In the home screen, press Settings
2.	 Select eve for ‘Mobile’
3.	 In the ‘Contacts’ section, enable ‘Add your favourites to Contacts’

NOTE:
•	 You can add favourites in your contact list by tapping the star at the upper
•	 right corner in the ‘Contacts’ view.
•	 The app will not delete the group or added contact when uninstalled.
•	 Everything Licence is required for Presence view

Me
The ‘Me’ view lets you see and manage your presence state, caller ID and your
information. Presence is used to show and manage if you are available for calls
or not. You can also change your presence information. 

Caller ID is the number which is presented on outbound calls that you make. You can 
change this number from your primary number so that you call from another number, 
for example, the switchboard or an attendant group.

To change your Activity
1.	 Select ‘Me’
2.	 Select ‘Set Activity’
3.	 Select the new activity – the activity is changed immediately

To change the Activity End Time
1.	 Select ‘Me’
2.	 Select ‘Set Activity End Time’
3.	 Set your end time and select ‘OK’
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The Activity will go back to the default activity when the time expires. When the end 
time is the next working day it will go back to the default activity based on the working 
hours configured by your administrator.

To change your Caller ID
1.	 Select ‘Me’
2.	 Select ‘Caller ID’
3.	 Choose your new outbound caller ID – if you want to call anonymously, unmark 

‘Show my caller ID’
4.	 Select ‘Done’

To set your Note
1.	 Select ‘Me’
2.	 Select ‘Set Note’
3.	 Enter your note – press the text field to bring up a keyboard if required
4.	 Select ‘OK’

If you are authorised, you can also change the information in the extra fields

To edit your extra information
1.	 Select ‘Me’
2.	 Select the edit icon next to the field you want to edit
3.	 Enter your new information and click ‘OK’

Change user photo
From the ‘Me’ view you can change your user photo.Click the photo with a small cam-
era icon. A camera view will open. In this view you can take a photo or open your photo 
gallery to select a photo. You can also modify your photo by applying a filter or zoom in 
and out using a pinch gesture on the photo preview.

Take a new photo
You can take a new photo using front or back camera. Select camera by
pressing the switch button. When the back camera is used you are also able to
select flash mode in the top right corner and change focus by pressing on the
photo preview.

1.	 Select ‘Camera’
2.	 Press the camera icon in the middle

Import a photo
1. Press the folder icon in the bottom right, the photo gallery will open
2. Select a photo

Apply a filter:
After a photo is taken or imported, a toolbar with filters will appear and you may
apply a filter to the photo.

1.	 Scroll the toolbar horizontally to find a suitable filter
2.	 Press the filter preview image

The filter will now be applied to your photo. You can switch through the filters by
selecting them or remove the filter by pressing the ‘ORIG’ button.
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Chats
The ‘Chats’ tab is not displayed when the user has a Collaboration licence.
You can send Chat messages to your colleagues with the application. Based on
your user profile, you may also have access to more advanced Collaboration
features. Collaboration gives much more capabilities and replaces the basic Chat
as soon as the other party is also enabled for Collaboration.

In ‘Chats’ you can view and manage all of your ongoing conversations plus all
ongoing Collaboration sessions. Find more information about the Collaboration
features in the ‘Collaboration’ section of this document.

To send a Chat message to, or start a Collaboration session with a contact:
1.	 From the ‘Contacts’ view or ‘Call log’, select the contact you want to start a  

Chat or collaborate with
2.	 Tap ‘Chat’
3.	 In the ‘Chats’ view, enter your message and send it

An Individual ‘Chat’ is started in the ‘Contact’s view. Hold down a contact, then
select ‘Chat’, or start it in the contact details view. Whenever the other user has
a Collaboration licence, a new Collaboration Chat will start. If the other user
does not have a Collaboration licence, a basic Chat will start. If a Collaboration
session with the other user already exists, it will be continued in the same Chat.

Group chat
A group Chat is always started from the ‘Chats’ view:

1.	 Navigate to ‘Chats’
2.	 Tap the ‘Group Chat’ button on top of the view
3.	 Set a title for the Chat
4.	 Select which participants you want to invite
5.	 Tap ‘Start’

NOTE: When starting a group Chat from an existing individual Chat, a new Chat
is created (no history is included). The original individual Chat remains as it was.

Remove chat
1.	 In ‘Chats’, tap ‘Edit’
2.	 Select the Chats you want to remove
3.	 Tap the trash icon

Dialler
You can use the dialler to make calls from your desk phone as well as call by Call
Back and transfer calls.
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Call log
The call log presents your log history in chronological order with latest item on
top. Here you can see information such as date, user, phone number, including
your missed, incoming and outgoing calls, associated call recordings as well as
voicemail if available.

Logs are gathered from all your devices connected to the system. Each log
entry shows the current presence status of the user, if available and has a quick
link to their contact details about the user, where you can see history and add
the user to your ‘Contacts’, either as a standard contact, a favourite, a VIP, or a
blocked contact.

You can filter to view all your calls or just missed calls. The inbox shows you
your adhoc call recordings. For the filtered result you can do a batch delete or
delete single log items. The menu option for log history will hold a badge that
reflects the number of unseen (new) missed calls or voicemail items, this will
also be propagated to the application icon badge.

NOTE: Update of the missed calls log can be delayed if the eve app is running in
the background.

To view your log history
1.	 Select Call log

To delete a log item
1.	 Select Call log
2.	 Press and hold on the log item you want to delete and press ‘Delete’. A 

confirmation pop-up will make sure you do not delete items by accident.

To filter on all, missed or inbox items
1.	 Select ‘Call log’
2.	 Select the filter option ‘All’ to view all your communication log items
3.	 Select the filter option ‘Missed’ to view your missed calls items
4.	 Select the filter option ‘Inbox’ to view voicemail and recordings

To view log history for a specific contact
1.	 Select ‘Call log’
2.	 Press the info icon on the right to see details about the related contact. In this 

view you will also be able to see your log history for this specific user.

To call back
1.	 Select ‘Call log’
2.	 Press the call icon to the right of the contact you want to call

To listen to voicemail
1.	 Select ‘Call log’
2.	 Press a given voicemail item. An info view will show up and tell you to answer  

the incoming call from your voicemail.
3.	 Answer the call from your voicemail
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To listen to a recording
1.	 Select ‘Call log’
2.	 Press the play button on the item you want to listen to

To perform more actions
1.	 Select ‘Call log’
2.	 Hold down a log item to pop up a menu with call, SMS, delete and  

view details actions

ACD Groups
The groups view lists the ACD groups that you are a member of.
NOTE: This view is only available if you are a member of an ACD group.

To login or logout of an ACD or Attendant group
1.	 Select ‘Groups’
2.	 Select the toggle next to the group you want to login or logout from.  

You can scroll down see more groups if all are not visible on the screen.

MiTeam
The MiTeam view is where you can create Collaboration sessions with your team
called Streams. Streams provide advanced tools for team interaction as well as
possibilities to schedule ‘Meets’, which is either a voice or a web meeting.

Streams are intended for long-term Collaboration, compared to Chat sessions
that are used for quick communication.

The MiTeam view will list your current Streams and Meets. Both the one you
have created yourself, accepted to be participants in, or you are invited to join.
A Meet that is about to start soon will appear at the top of the list.

To create a new Stream
1.	 Click the Stream icon and select ‘Create a Stream’
2.	 Enter a title
3.	 Select participants by searching your contacts
4.	 Press ‘Start’

The other participants will now automatically be invited to your Stream

To delete or leave a Stream
1.	 In the time line of ‘Streams’, click on the icon in the upper right corner
2.	 Click on either ‘Delete’ or Leave (depending on Stream ownership)
3.	 Confirm or cancel

NOTE:
•	 A Stream can only be deleted by the owner (the user who created it).
•	 Only participants (not the owner) of a Stream have the option to leave.
•	 When deleting or leaving a Stream, all Meets that the user has scheduled in the 

Stream will be cancelled.
•	 A Meet can be pre-arranged or created on demand. When a Meet is scheduled 

inside a Stream, the scheduler opens. As the first participant calls in to the 
scheduled conference, the Web Meet will be automatically initiated, and all 
participants are invited.
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To schedule a Meet for a Stream
1.	 Click the ‘MiTeam’ icon to view the list of your Streams
2.	 Select the Stream you want to schedule a Meet to and click the calendar  

icon on the right
3.	 Click +
4.	 Insert the name of the Meet
5.	 Select the from and to date and time.
6.	 Set a repeat sequence if applicable
7.	 Search and select participants, including any guests – you can add email 

addresses or phone numbers
8.	 Set the preferred meeting reminder time to the calendar invitation
9.	 Set the preferred time for SMS text message reminder
10.	 Write an invitation note – the text will be displayed in the invitation email  

and calendar event
11.	 Select the time zone
12.	 Click the menu in the top right of the screen to create the new Meet

To create a Meet live inside a Stream:
1.	 Click the ‘MiTeam’ icon to view the list of your Streams
2.	 Click on your Stream
3.	 Click ‘Meet’
4.	 Edit the participants so that only those that you want to be invited  

are set an invite
5.	 Click ‘Start Meet’

A Collaboration user without the Collaboration + licence will have a limited
feature set displayed. A user without the Collaboration + licence, your Meets are
limited to 10 minutes, file upload is limited to 5MB per file and it’s restricted to
two participants.

A Collaboration user with Collaboration + will have a 24-hour max length on
Meets, file upload limit size at 300MB per file and maximum 50 participants.

To join an ongoing or within ten minutes upcoming Meet do as below in the
MiTeam timeline:
1.	 Click the handset icon in the ‘Meet’ icon to join the voice conference
2.	 Within short the invitation to the Web Meet will be visible. Click on the  

‘Web Meet’ button to join.

If it is a voice only conference initiated from a user without MiTeam capabilities,
the option with Web Meet does not apply.

To delete a scheduled Meet
1.	 In the main list of scheduled Meets, click on the info icon of the Meet to be 

deleted
2.	 Click ‘Delete’
3.	 Confirm delete

To edit a scheduled Meet
1.	 In the main list of scheduled Meets, click on the info icon of the Meet to be edited
2.	 Click ‘Edit’
3.	 Edit the Meet
4.	 Confirm the changes
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Future Presence
The menu item Future Presence adds the possibility to schedule future presence
changes. User Activity and Role can be set to change at any point in time at
least 10 minutes into the future and it must be a minimum of 5 minutes duration.

When adding a Scheduled Presence, you must also set the time zone for the
start and end time. Your default time zone will be suggested automatically,
however, you are able to set another if you please. You can edit the time zone
for the Scheduled Presence item just like any other information.

The menu item to schedule Future Presence changes requires a licence for the
functionality to be present. When chosen, the user will see a page where all
scheduled presence changes are listed for easy access and editing. Presence
changes triggered by scheduled events can be ended or altered at any time.

Times and dates of the scheduled presence changes will be listed month by
month in order of occurrence and date. Presence changes may be edited or
even deleted. ‘Edit’ and ‘Delete’ buttons will be present in the expanded view of
the list item if available.

It is possible to synchronize Future Presence changes with external sources.
Currently, only synchronizing with Microsoft Exchange servers are possible.
Synchronization with external sources is one-way only. A presence change set
through Microsoft Exchange and synchronized to eve for Mobile will show up
in the app, but changes to it in the mobile application will not affect presence
settings on the exchange server.

To set a future presence change
1.	 Press the Add Scheduled Change icon to display the ‘Schedule settings’ page
2.	 Specify a change in ‘Activity’, ‘Role’ or both.
3.	 Set the duration of the change in ‘Presence’. The duration must be set at least 10 

minutes into the future and last for a minimum of 5 minutes.
4.	 The suggested time zone for the start and end time of the event will be your 

default time zone, however, you can set any time zone you wish.
5.	 If desired, the change can be set to recur every day or on specific days of the 

week, monthly or yearly. A repeating presence change isn’t allowed to overlap 
with its next occurrence. Every day and per week occurrences can’t span more 
than 24 hours, while single occurrences and every month or every year may last 
longer.

6.	 The repeating of the presence change will be indefinite unless an end date is set. 
NOTE: Please note that because events may span several days, and the End date 
defines the last occurrence of this event.

7.	 Save the scheduled presence change to close the view and to return to the 
Scheduled presence changes view, where the newly created event will have been 
added to the list.

To edit a future presence item
1.	 Enter the Future Presence view where all future presence changes are listed.
2.	 Press and hold an event for 2 seconds to bring up the Edit or delete menu. 

Alternatively, press the Edit presence item icon in the list.
3.	 Choose to ‘Edit’ or click ‘Cancel’ to abort and return to the ‘Future Presence’ view.
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4.	 The Edit scheduled presence view will be displayed. You can edit the Name, 
Activity, Role, Note, Start, End and Time zone data by clicking on the 
corresponding fields.

5.	 Click on the ‘Accept changes’ button to perform the edit or the ‘Cancel changes’ 
button to abort the edited data.

6.	 The ‘Future Presence’ view will be updated and displayed with the edited 
presence item.

To delete a future presence item
1.	 Enter the ‘Future Presence’ view where all future presence changes are listed.
2.	 Press and hold an event for 2 seconds to bring up the ‘Edit or delete’ menu. 

Alternatively, press the ‘Edit presence’ item icon in the list.
3.	 Choose to ‘Delete’ the scheduled presence item. Alternatively, click ‘Cancel’ to 

abort and go back to the ‘Future Presence’ view.
4.	 If you choose to delete a scheduled presence you will be asked to confirm your 

decision. Regardless of whether you confirm or cancel the delete operation, you 
will be brought back to the ‘Future Presence’ view.

5.	 Deleted scheduled future presence changes will be removed from the ‘Future 
Presence’ view.

Activity Diversion
Activity diversion is a feature to enable call diversions based on your activity.
You set which activities should have a call diversion and the number the calls
should be diverted to.

For example, if you are on annual leave you can set your activity to ‘Holiday’ and
set up a divert to the main office number. That will automatically divert all your
calls to that number when you set your activity as ‘Holiday’.

Selecting an activity to a mapped diversion number will divert your incoming
calls to that number.

Existing diversion numbers set to activities are presented in a list. You can add a
new diversion number and can also edit or delete an existing one.

To add a new diversion number
1.	 Press + icon
2.	 Select activity
3.	 Enter number where you want your incoming calls to be diverted
4.	 Select ‘Done’

To edit or delete a diversion number
1.	 Hold down the desired item
2.	 Select ‘Edit’ or ‘Delete’
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Calls
To call a contact
1.	 1. Select the contact you want to call. Search for the contact if necessary. The 

presence icon provides information if the contact is available or not.
2.	 To call a native address book contact, search for the contact using the app. Open 

the detail view by clicking on the contact. By clicking the phone icon for a number, 
a native GSM call will be initiated, or by clicking the number row the app will start 
a call based on the dialling settings.

The user can configure either to call direct or to make a Call back call. This is
where the system calls the user and connects the call. When calling via call back
you need to call via the office phone dialler.

To set call type
From your main view, select ‘Settings’ > ‘eve for Mobile’, then enable Call back.
Direct calls are used if this is not enabled.

Transfer calls
The Transfer functionality allows you to transfer an ongoing call to a third party.
You can set your preferred (default) transfer type in your phone settings to be
attended, blind, or ask per call.

A Blind transfer is where a user transfers a call by dialling their number and putting
the phone down, rather than waiting for the other user to answer and introducing
the call. If the call is not answered it will bounce back to that original user.
Once initiated, Blind transfers cannot be cancelled.

An Attended transfer makes it possible to transfer a call and speak to the user
it’s being transferred to, to introduce the call before transferring. For Attended trans-
fers, a banner is shown at the top of the app from where you can cancel
the transfer. If you cancel the transfer, you will be connected to the calling party
again. Once initiated, the transferring party loses the link to the call and it is not
possible to get the call back.

To set the default transfer type for calls
1.	 Go to your phone settings
2.	 Scroll down to the eve app
3.	 Go to ‘Call transfer’ and tap ‘Transfer type’
4.	 Choose one of the following:
•	 ‘Always blind transfer’ – A Blind transfer is initiated every time a call is transferred
•	 ‘Always attended transfer’ – An Attended transfer is initiated every time a call is 

transferred
•	 ‘Always ask’ – A pop-up is shown every time asking whether the transfer should 

be Attended or Blind
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To transfer a call to a contact
1.	 During an ongoing call that you want to transfer, go to the ‘Contacts’ view in the 

eve Mobile app
2.	 Choose the desired contact from the favourites list by searching for the contact
3.	 Tap the ‘Transfer’ button on the contact card 

NOTE: The app behaviour varies depending on the transfer type selected in the 
phone settings. This procedure assumes that transfer type is set to ‘Ask for each 
call’.

4.	 Select the desired transfer type in the pop-up: Attended or Blind 
NOTE: Clicking ‘Cancel’ in the pop-up aborts the transfer process.

5.	 For Attended transfer: Put the phone down to transfer the call 
NOTE: Clicking ‘Cancel Transfer’ in the app banner cancels the transfer and the 
caller is reconnected with the initial user.

6.	 For Blind transfer, Call transfer is automatically initiated. The app shows a 
message ‘Transfer initiated’

To transfer a call to a new number
1.	 During an ongoing call that you want to transfer, go to transfer Dialler and add the 

number you wish to transfer to
2.	 Enter the number in the dialler and tap the transfer icon
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Portal guide

Welcome to the eve portal user guide. This document is a quick start guide for end users.
For Administrator guides, please contact your service provider. Some features may vary 
depending on handset and user types.

Quick Configurations 
enable you to decide 
how to handle incoming 
calls to your DDI. You 
can choose which 
configuration to apply 
here. 

Quick Configurations 
are set using the ‘call 
settings’ link in the header

Global keyword search - 
searches across all eve 
assets i.e. Users, Groups, 
Sites

Click to access and edit 
your user profile

Your personal contacts 
are displayed here. 
These are only visible to 
you and are separate to 
the company directory

Last ten events in your 
call history are listed here. 
You are able to call 
contacts directly from 
the contact card

Use the drop down box 
to set your Status

Call Queues that you  
are a member of are 
displayed here. 

You can use the 
toggle switch to log 
in and out of these 
queues

Personal contacts can 
be uploaded in bulk 
format

Return to home

Access to Call Recordings 
for admin use

Access to call logs Log in / Log out

Home Screen
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Click the + symbol 
to create new
Configuration

Give the Configuration 
a name

When Display is turned 
on, the Configuration 
will be available to 
select in the Quick 
Configuration
box on the home 
screen

Select Status to 
be applied when 
Configuration is 
activated

When Divert No Answer is activated, you will 
be prompted to select a phone number from a 
drop down box. 

This is the number your calls will be diverted to 
if you don’t pick-up

How long your 
phone will ring 
before diverting

When Divert Busy is activated, you will 
be prompted to select a phone number 
from a drop down box. 

This is the number your calls will be 
diverted to if you are already on a call

Personal Call Queue - If 
you are on a call and a 
receive a second call, the 
second caller
will hear on-hold music 
until the current call ends. 
NB Personal

Call Queue and Divert 
Busy cannot be active 
simultaneously

Activate/ Deactivate 
your Voicemail

Select a 
Configuration to 
activate it

Call settings
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Configuration screen

A ‘No Entry’ 
sign means the 
field can only 
be edited by an 
administrator

Your direct phone 
number

The number 
presented when 
you make a call

To activate Fax 
to Email, select a 
number from the 
drop-down list.

Any faxes sent to 
this number will 
be emailed to the 
email address in 
User Details

Voicemail
Notifications: 

None:
No email 
notification.
Voicemail 
notifications will 
only appear on 
handset and/or 
apps

Email:
You will receive an 
email informing
you that you 
have a voicemail 
message

Email + Audio: 
Attachment - 
You will receive 
an email with 
an audio file of 
the message 
attached

This is the name that 
other users see when 
you call

Email for receiving
notifications

Voicemail pin

Your internal 
extension number

Create Activity Diversions 
based on your Status,
e.g. When your Status is 
set to Busy, divert
calls to a mobile number
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Barring options 
are controlled at 
administrator level

For reference purposes only. 
Displays the call groups you 
are a member of

Shows the devices 
associated to your account. 
Clicking Edit will take you to 
the Device
Configuration screen

The keys highlighted in 
blue can be programmed to 
perform different functions

List of currently 
programmed 
keys, with the 
corresponding
function

Configuration screen (cont.)
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Definition of functions that can be assigned 
to handset keys:

Monitor other users within your 
company. A red light indicates that 
their line is busy, green means 
they are available to take a call

Change your active Status

View call history

Access to the company directory 
including personal contacts

Answer calls that are made to 
other members of your Pickup 
Groups

Park a call, this will be visible to 
other people within your Pickup 
Group

Answer a parked call

Display contacts you’ve set as your 
favourites

Access to a sub-menu of 
voicemail, group voicemail 
and presence menu

Select any Status categorisation 
from a sub-menu

Dial in to your individual Voicemail

Sub-menu of queues you are a 
member of, select a Queue to log 
in/out

Speed-dial


